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Appendix A 

Toolbar and Menu Reference 
This chapter provides brief descriptions of each command on the BSD CostLink/AE 
toolbars and menus. Where appropriate, it provides references to other sections of 
the manual for more information. 

• BSD CostLink/AE Toolbars 

• Menus 

• Context Menus 
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BSD CostLink/AE Toolbar 
The toolbar is displayed at the top of the BSD CostLink/AE program window, just below the 
menu bar. You can turn the toolbar on and off using the Toolbars command on the View 
menu. 

NOTE: You can change and arrange the buttons shown on the BSD CostLink/AE toolbar. 
See Chapter 6 for instructions. 

Toolbar Buttons 

 Create a new project. Displays the New dialog box, which you use to 
select a template for CostLink/AE to use as the basis of the new project. 

 Open recently used projects dialog. Displays the Recently Used dialog 
box, which you can use to select from recently used projects. You can also 
click Browse to search for and open other projects that are not visible in 
the Recently Used dialog box. 

Refer to Chapter 4 for information on opening projects.  

 Close. Closes the currently active project along with its resource windows. 

 Print selected report. Prints the report(s) as currently selected and 
formatted in the Reports dialog box. 

 Print selected report to preview window. Displays a preview of the 
reports as currently selected and formatted on the Reports dialog box. 

 Select and format reports. Displays the Reports dialog box for selecting 
and formatting reports. 

Refer to Chapter 5 for information on Reports. 

 Find. Displays the Find In dialog box for finding information in the current 
project or resource window.  

 Recalculate the current project. Causes CostLink/AE to recalculate the 
estimate. (Not available when the current window is a resource window.) 

 Cut. Removes the currently highlighted folder or task (assembly or line 
item) and places it in the Windows Clipboard. Can also be used to remove 
currently highlighted text and place it in the Windows Clipboard. This is 
used in conjunction with Paste as a way to move assemblies or line items 
within your project. 



A p p e n d i x  A  :  T o o l b a r  a n d  M e n u  R e f e r e n c e  

 B S D  C o s t L i n k / A E  U s e r  M a n u a l  1 1 9  

NOTE: If you want to permanently remove a folder, task, or text use Delete 
selected item . Only use Cut if you want to Paste the folder, task, 
or text in a different location. 

 Copy the selected item to the clipboard. Copies the currently 
highlighted task (or text) to the Windows Clipboard. 

NOTE: CostLink/AE permits you to Copy but not Cut in some cases. For 
example, you can Copy but not Cut tasks or folders from the 
Assemblies resource window. 

 Paste. Places the current contents of the Windows Clipboard (text or 
tasks) into the location of the cursor. 

 Delete selected item. Deletes the selected task or folder. CostLink/AE 
prompts you to confirm the deletion. 

NOTE: When you delete a folder with subordinate folders or tasks, 
CostLink/AE prompts you to specify whether to move the 
subordinate tasks to the Unassigned folder. This allows you to assign 
the tasks to another folder rather than deleting them. 

 Open the Summary Info dialog. Displays the Summary Info dialog box 
for the current project. 

Refer to Chapter 4 for information on the Summary Info dialog box. 

 Open item form on the Tree panel. Opens an item form for the folder 
that is currently selected in the Tree panel. 

 Open item form on the Sheet panel. Opens an item form for the folder or 
task that is currently selected in the Sheet panel. 

 Open the Notes form. Opens a Notes and Pictures form for the currently 
selected folder or task. 

Refer to Chapter 6 for information on adding notes and pictures. 

 Use single tab for tree. Displays all folders in the project or resource 
window on a single tab rather than one tab for each top-level folder. 
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 Show folder tags. Shows the tags of each folder in the tree panel.  

Caution: If you insert a new folder with Show Folder Tags turned on, and if 
you type the name in the Tree panel rather than the Folder Form, the first 
characters you enter (up to the first space character) become the Source 
Tag for the new folder. To avoid problems with this, either enter the Folder 
Tag first, enter a space as the first character when you insert the new 
folder, turn Show Folder Tags off, or enter the name in the Folder Form. 

 Show folder data in Tree. Shows summary costs and other information 
for each folder in the Tree Panel. (Not available when a resource window 
is the current window). 

 Expand Branch. Expands the display in the tree panel to show all items 
below the current folder. 

 Show all folders. Expands the Tree Panel to display all folders. 

 Open Assemblies resource window. Displays the Assemblies resource 
window for the current project. 

Refer to Chapter 4 for information on the Assemblies resource window. 

 Open Unit Prices resource window. Displays the Unit Prices resource 
window for the current project. 

 Tile windows horizontally. Arranges all open windows horizontally. 

 Tile windows vertically. Arranges all open windows vertically. 

 Stack windows in cascade. Arranges all open windows one atop the 
other with their left and top portions visible. 

 Open Help to Contents. Displays the CostLink/AE Help contents tab. 

Refer to Chapter 3 for information on BSD CostLink/AE Help. 

Menus 
BSD CostLink/AE provides commands on the following menus, located on the menu bar at 
the top of the main window: 

 

Menu bar 
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File Menu 
New Project Creates a new project. Displays the New dialog box, which you use 

to select a template to use as the basis of the new project. 

Open Displays a flyout menu with options for opening projects and resource
windows. You can select the Recently Used dialog box to choose 
from recently opened projects, or you can select one of the resource 
windows if a project is open. 

Close Closes the current project and its resource windows. 

Summary Info Displays the Summary Info dialog box, which you use to enter 
information relevant to the project as a whole. 

Refer to Chapter 4 for information on the Summary Info dialog box. 

Reports Setup Displays the Reports dialog box for selecting and formatting reports. 

Refer to Chapter 5 for information on reports. 

Print Setup Displays the Windows Printer Properties dialog box, which you can 
use to change your Windows printer settings. 

Print Preview Displays a preview of the printed reports as currently selected and 
formatted on the Reports dialog box. 

Print Prints the reports as currently selected and formatted on the Reports 
dialog box. 

Copy Use this command to copy a project. 

Refer to Chapter 6 for more information on copying projects. 

Load from 
Compressed 

Use to load projects that have been saved in compressed format. 
The Select Compressed File Path dialog box is displayed for you to 
select the compressed project. 

Refer to Chapter 6 for information on Load from Compressed and 
Save to Compressed. 

Save to 
Compressed 

Saves the current project in compressed format. The Select 
Compressed File Path dialog box is displayed for you to choose the 
name and location for the compressed project. 

Compact 
Database 

Use this command when BSD CostLink/AE has problems opening a 
project. This can occur if a project becomes very large or corrupted. 
Make sure the project is closed, then choose this option. BSD 
CostLink/AE displays a dialog box for you to select the project to be 
repaired and compacted. 

Refer to Chapter 6 for information on compacting databases. 
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Permissions Opens the permissions dialog box for inputting the access key and 
accessing system settings. (Available only when no projects are 
open.) 

Refer to the Installation document available on the Install BSD 
Products screen of the most recent BSD SoftLink CD for more 
information on Permissions. 

Recently 
Opened 
Databases 

This list shows the four most recently opened projects. Click on any 
project to open it. 

Exit Closes all open projects and resource windows and exits 
CostLink/AE. 

Edit Menu  
Cut Removes the currently highlighted folder or task (assembly or line 

item) and places it on the Windows Clipboard. Can also be used to 
remove highlighted text and place it on the Windows Clipboard. This 
is used in conjunction with Paste as a way to move assemblies or 
line items within your project. 

NOTE: If you want to permanently remove a folder, task, or text use Delete. 
Only use Cut if you want to Paste the folder, task, or text in a different 
location. Refer to Chapter 6 for more information on Cut, Copy, and 
Paste. 

Copy Copies the currently highlighted folder, task, or text to the Windows 
Clipboard. 

NOTE: CostLink/AE permits you to Copy but not Cut in some cases. For 
example, you can Copy but not Cut tasks or folders in the 
Assemblies resource window. 

Paste Places the current contents of the Windows Clipboard into the location
of the cursor. 

Delete Deletes the selected task or folder. BSD CostLink/AE prompts you to 
confirm the deletion. (Available in project windows only.) 

NOTE: When you delete a folder with subordinate folders or tasks, 
CostLink/AE prompts you to specify whether to move the 
subordinate tasks to the Unassigned folder. This allows you to assign 
the tasks to another folder rather than deleting them. 
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Find Displays the Find in dialog box for finding information in the current 
project or resource window.  

Refer to Chapter 6 for information on using Find. 

Select All 
Tasks 

Selects all of the tasks currently listed in the sheet panel. You can use 
this command when you want to delete or copy all tasks beneath a 
certain folder. 

View Menu 
with Horizontal 
Panels 

Displays the data in the current Window with a tree panel on top and 
sheet panel on the bottom. This is the default arrangement. 

with Vertical 
Panels 

Displays the data in the current Window with a tree panel on the left 
and sheet panel on the right. 

Tree Items 
Form 

Opens the item form for the current folder in the tree panel. 

Sheet Items 
Form 

Opens the item form for the current folder, assembly, or line item in the 
sheet panel. 

Notes Window Opens the Notes form for the current folder, assembly, or line item for 
adding notes or pictures. 

See Chapter 6 for information on adding notes and pictures. 

Tree Panel Turns on and off the display of the sheet panel in the current window, 
making the Tree Panel the only panel visible. Click Tree Panel again to 
make the sheet panel visible again. 

Sheet Panel Turns on and off the display of the tree panel in the current window, 
making the Sheet Panel the only panel visible. Click Sheet Panel 
again to make the tree panel visible again. 

Toolbars Displays a flyout menu for you to turn on or off the display of the 
different toolbars or to customize the toolbars. 

Status Bar Turns on and off the display of the status bar at the bottom of the BSD 
CostLink/AE main window. 

Tree Menu 
Up One Level Highlights the folder above the currently-selected folder in the Tree 

Panel. 

Down One 
Level 

If not already showing, displays the next lowest level of the folder 
hierarchy in the tree panel and highlights the first folder below the 
current folder. 
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Go to Folder Displays a flyout menu for you to choose different folders to select in 
the tree panel. Choices are:  the first and last folders, and the next 
and previous folders relative to the currently selected one. 

Use Single 
Tab 

Displays all folders in the project on a single tab rather than one tab 
for each top-level folder. (Not available when a resource window is 
the active window.) 

Show 
Hierarchy 

Displays a flyout menu for you to choose different levels of the folder 
hierarchy to display: 1, 2, 3, or 4 levels. 

Expand 
Branch 

Expands the display in the tree panel to show all folders below the 
current folder. 

Expand All Expands the display in the tree panel to show all folders. 

Show Folder 
Tags 

Shows the tags of each folder in the tree panel.  

Caution: If you insert a new folder with Show Folder Tags turned on, 
and if you type the name in the Tree panel rather than the Folder 
Form, then the first characters you enter (up to the first space 
character) become the Source Tag for the new folder. To avoid any 
problems with this, either enter the Folder Tag first, enter a space as 
the first character when you insert the new folder, turn Show Folder 
Tags off, or enter the name in the Folder Form. 

Show Data in 
Tree 

Show summary costs and other information with each folder in the 
tree panel. (Not available when a resource window is the current 
window). 

Insert Menu 
NOTE: This menu is used to add new folders and line items to your project. It will not be 

available when a resource window is the active window. The new folders and line 
items will be empty. To enter names, descriptions, and other information, highlight 
the new item with the right mouse button, and choose Edit Folder or Edit Item. 

Folder Adds a new folder at the same level and before the folder currently 
selected in the tree panel. 

NOTE: To insert a folder at Level 1 (the top level folders in your project) 
your project folders must be displaying on a single tab. The Use 

single tab button will appear pushed in ( ) if you are in single tab 
mode. Then select the top folder (it says your project name) and 
choose Insert > Child Folder. 
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Child Folder Adds a new folder at the level below the currently selected folder in 
the tree panel, and after any existing subfolders. 

Task Adds a new line item to the folder currently selected in the tree panel. 

LinkMan Menu 
NOTE: Options on the LinkMan menu are only available when a project is the current 

window. 

Paste Link 
from Source 

Pastes a link from a copied value in Excel to the quantity of the 
currently-selected folder, or task (assembly or line item). 

Refer to Chapter 7 for more information on linking. 

NOTE: You must have Excel 2000 (version 9.0) or higher to create links 
between CostLink/AE and Excel. 

Delete Link 
from Source 

Removes the link between either a parent folder or a value in Excel, 
and the quantity of the currently selected folder or task. 

Refresh All 
Links From 
Sources 

Updates the quantities of all linked folders and tasks. 

Change 
Excel Links 
Source 

Opens a dialog box for selecting a different Excel workbook as the 
source for linked quantities in the project. 

Disable 
Updating 
from Sources 

This command is a toggle for disabling and enabling automatic 
updating of linked quantities. Editing a linked project will be faster with 
automatic updating disabled. 

Remove All 
Links from 
Sources 

Removes all links in the current project, so that if the link source is 
edited, the quantities in the project do not change. 

Tools Menu 
Recalculate All Causes BSD CostLink/AE to recalculate the current project. (Not 

available when a resource window is the current window.) 

Auto-
Recalculate 
Markups 

When checked, this option causes BSD CostLink/AE to recalculate 
the Markups in the project automatically as you make changes. You 
are able to see the changes in the Tree Data immediately. Editing a 
project will be faster with this option turned off. Click the option to 
turn it on and off. 
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Prompt Before 
Completing 
Drag 

When checked, this option causes BSD CostLink/AE to issue a 
prompt requiring you to confirm all drag and drop operations. Click 
the option to turn it on and off. 

Delete Empty 
Folders 

Deletes all empty folders in the project. BSD CostLink/AE prompts 
you to confirm the operation. (Not available when a resource 
window is the current window.) 

NOTE: Empty folders at Level 1 are not deleted. If you want to delete an 
empty folder at the top level, select it in the tree panel and choose 
Edit > Delete. 

Change RS 
Means 
Database 

Select this option in order to copy costs from a different RS Means 
database. For example, if you created the project in 2005, then you 
are copying costs from the 2006 RS Means database. Select this 
command to be able to copy costs from the most current RS Means 
database in to the current estimate. 

Refer to Chapter 6 for more information on using different 
RS Means databases. 

Update RS 
Means 
Database 

After you use “Change RS Means Database,” choose this 
command to reprice all items copied from the original RS Means 
database to the corresponding costs in the newly selected RS 
Means database. 

Customize 
Tools Menu 

Displays the Customize Tools Menu dialog box, which allows you to 
launch other applications (like the Windows calculator) from your 
Tools menu. 

Refer to Chapter 6 for instructions on customizing the Tools menu. 

Window Menu 
Arrange Icons Arranges the icons of all windows you have minimized at the bottom 

of the CostLink/AE main window. 

Tile 
Horizontally 

Arranges all open windows horizontally. (Minimized windows will not 
be tiled.) 

Tile Vertically Arranges all open windows vertically. (Minimized windows will not be 
tiled.) 

Cascade 
Windows 

Arranges all open windows one atop the other with their left and top 
portions visible. (Minimized windows will not be cascaded.) 

New Window Opens a new window containing the same data and view as the 
currently selected window. Use this command to open two windows 
of your project to copy or move folders and tasks within the project. 
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Open 
Windows list 

The list shows all CostLink/AE windows currently open. Click on a 
window to make it the current window. If not currently visible, the 
window will also become visible. 

Refer to Chapter 3 for information on controlling the display. 

Help Menu 
Contents Displays the Help Contents tab. The Contents tab is similar to the 

table of contents in a book. Each book icon represents a subheading 
in the Help file. Each page icon represents a topic. 

Index Displays the Help Index tab. The Index tab is used to search Help by 
keywords for each topic. 

Search  The Search tab is used to conduct a full-text search of all Help topics. 
Use the Search tab if you cannot find the Help you need using the 
Contents or Index tabs.. 

About BSD 
CostLink/AE 

Displays information on the BSD CostLink/AE version, along with 
diagnostic information on your computer. 

Context Menus 
Context menus are a quick way to access key BSD CostLink/AE functions. You display 
context menus by positioning the cursor in a particular location and clicking the right mouse 
button. Which options are displayed depend on your location (the context). 

The commands available on the context menus are equivalent to commands on the 
Toolbars and Pulldown menus.  

The following is an example of a context menu. 

 

Example of a context menu 
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